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LHV Trader trading rules 
  

 

1. How to open an LHV Trader account 

In order to use the LHV Trader trading platform, it is necessary to sign a contract for using the LHV Trader trading platform, 
to fill in the appropriateness test information and choose a password for the platform. It is necessary that the length of the 
password of the trading account would be at least 6-8 characters, including at least one number. 

You can sign a contract in our office or in the internet bank > INFORMATION AND SETTINGS > Agreements > LHV Trader 
> Conclude agreement. The appropriateness test could be done in the internet bank > INFORMATION AND SETTINGS > 
Appropriateness test. 

During several days there will be new account opened in the internet bank called “Trader account” which you can use to 
transfer funds to and out of Trader account. For that choose EVERYDAY BANKING > Payments > for Payment type choose 
“Payment between own accounts” and for destination account choose Trader account. The next step is to transfer at least 
USD 5,000 or the corresponding amount in euros into the Trader account, after which the activation process will start for the 
LHV Trader account, with the user name for the trading system sent by e-mail within 5 business days.  

LHV Trader grants the customer direct access to the trading venues, which means that the customer is responsible for all 
the orders transmitted. Transmitting orders directly to the stock market ensures that they will be executed quickly; however, 
trades could be cancelled in rare cases only when corresponding to the parameters specified in section 6.4 “Request a 
trade cancellation”. Trade cancellation requests are handled on a best efforts basis only. LHV cannot guarantee your re-
quest will be processed within the exchange mandated time limits or will be otherwise accepted by the exchange. 

 

Additional rules for traders 

 To start trading, there must be a minimum of USD 5,000 or the corresponding amount in euros on the account. 
To use leverage, there must be at least USD 2,000 on the account; otherwise leveraged positions will be liquidated 
automatically.  

 Clients who are under 21 years old are not permitted to use margin. 

 As LHV Trader is a freestanding trading platform, money transfers will reach the account in one banking day; if the 
money transfer is done during business hours (between 9.00-17.00 Estonian time), then usually in one hour. The same 
condition applies for withdrawing funds from the LHV Trader account. 

 Traders must adhere to the day trader rules, which do not apply if the account balance exceeds USD 25,000. 

 Traders must always select SMART as their exchange destination, which gives the best quotations from different stock 
exchanges and ensures the best price available for the customer. When choosing a stock exchange manually, a higher 
service fee may apply. 

 The following types of currency can be transferred into the LHV Trader account: USD, EUR, GBP, CHF, HKD, CAD, 
AUD, JPY, SEK, RUB, NZD, NOK, HUF, DKK, PLN and CZK. 

 Many exchanges charge fees to their members for orders that are cancelled or modified, and LHV charges certain re-
lated fees to its customers to cover these exchange fees. 

 The Depository Trust Company (DTC) collects custody fees on behalf of ADR agents for ADRs which do not pay peri-
odic dividends. The fees are deducted by DTC in monthly billing and will be passed to accounts, which held the ADR 
on the record date. ADR fee range is 0.01 to 0.03 USD per share. 

 Transactions conducted at the platform are settled according to T+2 rule. 
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2. Recommended System Requirements 

  PC Minimum
Requirements

PC 
Recommended

Mac Minimum
Requirements

Mac 
Recommended

Operating System Windows Vista Windows 7 or higher Mac OSX 10.9 Mac OSX 10.11

Browser Internet Explorer 11.0

Firefox 32.0

Chrome 37.0

Safari 7.1
Firefox 32.0

Chrome 37.0

Java Java 7.0 (1.7.0_40) Java 7.0 (1.7.0_45) Java 7.0 (1.7.0_40) Java 7.0 (1.7.0_45)

Screen Resolution 1024 × 768 Dual Screen, 

1280 × 1024

1024 × 768 Dual Screen 1280 × 1024

Processor Intel i3 Intel i5
or higher 

Intel i3 Intel i5 or higher

Memory 4GB Ram (1GB availa-
ble for LHV Trader)

8GB Ram (2GB available for 
LHV Trader)

4GB Ram (1GB available 
for LHV Trader)

8GB Ram (2 GB available 
for LHV Trader)

Internet Connection Broadband Broadband with Backup Broadband Broadband with Backup

 
LHV Trader requires Java Runtime Environment 7.0 (version 1.7.0_40 or newer). You can download it here: 
http://www.java.com/en/download/manual.jsp. After installing newer version of Java please uninstall older Java version. 

 

 

3. Getting started 

3.1 Log in to Trader 

The LHV Trader program can be downloaded from lhv.ee/trader or from the online bank, in the section INVESTING > LHV 
Trader.  

After installation, when the login window opens, enter your LHV Trader user name and password and click the “Log in” but-
ton. If the fields for data entry are not visible, you need to install Java software on your computer. More detailed information 
on downloading the software is provided in the log in window. Note: do not close the window after logging in, as it is neces-
sary for running LHV Trader. 

 

Information in the log in window 

„Select language“ – The language selector enables you to choose between English, Russian, Estonian and Lithuanian in 
order to see the platform in the desired language. 

„Color Palette“ - The color palette allows you to choose a new color skin for LHV Trader . If you select a palette and want 
to change it once you have logged in, use Edit > Global Configuration > Display > Style. 

“Settings directory“ - By default, files are saved in C:\Jts. If you would like to change the location of your LHV Trader set-
tings files, use the Browse button to specify a new directory. 

„Use/store settings on server“ - This option allows you to save your LHV Trader settings,  including market data, pages 
etc., on our server instead of your local machine.  If checked, your workstation will have the same data and look regardless 
of your login location. If not checked, settings are only saved on the computer you are currently using.  
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„Use SSL“ - Checking this box option gives additional privacy and integrity to your order information as it travels over the 
internet. Minor performance impacts may be experienced depending on the capabilities of your PC. 

 

How to save and restore Page Settings 

To save your settings you have set up in the platform go to File > Save settings as > and then choose a file name and loca-
tion where the settings file of your platform will be saved. 

To restore your platform setting including trading pages and tickers you had set up previously, you can select to restore the 
entire settings file, which includes all trading pages and their tickers. Restoring a page file completely replaces all of your 
current trading pages with new settings. 

To restore settings 

 On the File menu, select File > Settings Recovery. 
 In the Open dialog box, click on the day's file you want to use or choose “Custom” button to use previ-

ously saved file to replace the current set of pages and tickers. 
 Then click OK. Your current trading pages and tickers will be replaced with those in the file you se-

lected. 

3.2 Add market data 

Before you trade, you’ll want to add market data lines for your assets. A market data line represents an individual ticker and 
displays the product type, order destination, ask and bid prices, and other defining attributes. You can add a market data 
line by typing a symbol, ISIN code or company name directly into the Contract/Underlying column of the trading screen. 

 
To add market data to the trading screen:  

 Click in the Contract/Underlying field in an empty row. 

 Enter an underlying symbol and press ENTER. 

 Select a contract from the list on the trading screen. For instruments that require an expiry, choose a month and year, 
or select “All” or “More” to open the contract selection box. It’s important to note that selecting Smart or Directed in this 
step affects both market data and default order routing. You can modify the routing destination on a per-order basis 
using the Destination order field. 

 In the Contract Selection box, select a contract(s) and click OK. You can limit the contracts displayed in the right pane 
by selecting criteria from the Filter section. Choose Smart as the exchange to use SmartRouting. 

 

3.3 Create an order 

There are many ways to create orders in Trader. This topic shows you how to create and transmit an order directly from a 
ticker line in the Quote Monitor. 

Click the Ask or Bid in a market data line to create an order line directly below the selected ticker. 

 Click the Ask to create a Buy order. 

 Click the Bid to create a Sell order. 

On the Order line, modify the order parameters including Time in Force, Action, Quantity, Price, Order Type or Destination, 
if needed. 

 
From the column “Type”, it is possible to set the type of the order – market order (MKT), limit order (LMT), stop limit order 
(STP LMT), relative order (REL), trailing order (TRAIL). 

In case of limit and stop orders, the price limit (the column “Lmt. Price”) and the validity term of the order (in the column 
“Time in Force”) must be set, (DAY) is only one day, (GTC) is good ´til cancelled. 
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To transmit your order, click the “Transmit” in the Transmit field. 

To cancel a working order click the grey “Cancel” button in the Cancel field. 

By default, a working order will display on any page that has the ticker. You can modify where you want working orders to 
be displayed using the Page settings. 

All pending orders are listed on the Pending page, so that you can always get an overview of the valid orders. 

When using LHV Trader for the first time, the default mode is to trade during regular trading hours, and in order to partici-
pate in the primary and secondary market, you need to select Edit > Global Configuration > Presets > and tick the box ‘Allow 
orders to be activated, triggered or filled outside regular trading of hours (if available)’. When permitting single orders on the 
primary and secondary market, the box ‘Allow this order to be filled outside of regular trading hours’ must be checked on the 
order Time in Force bar menu. Please note that not all orders are available outside RTH as long as some orders can work 
only both RTH and outside RTH (like some futures limit and other orders). 

 

3.4 Trades summary 

The Trade Log window displays reports for daily executions including those completed during after-hours trading. To see 
trades click the Trade Log icon on the trading toolbar. 

To add or remove columns from the Trades tab: 

 Right-click in any column heading and select Layout. 

 Check the columns you want to include; uncheck columns you want to hide. 

Column name Description 

Action The action, either Bought or Sold. 

Quantity The number of units in the trade. 

Underlying Underlying symbol. 

Comb If checked, identifies the trade as a combo trade. Use the “+” sign to expand the combo  
and view individual legs. 

Description The contract description. 

Price Transaction price. 

Currency The currency in which the position is held. 

Exchange The exchange that executed the order. 

Date The execution date. 

Time The execution time. 

ID The order ID. 

Order Ref. The order reference number as defined by the user on the Order Ticket. For basket orders,  
this field contains the name of the basket to which the order belongs. 

Commission Commission charged on the trade. 

Vwap Time For VWAP orders, the time at which the order executed. 

Comment Displays comments relative to the order. 

Account Identifies the beneficial account number. 

Submitter Identifies the order submitter. 

 
You can view transaction statistics for the last seven calendar days in the Trades window, earlier transaction statistics could 
be found in the internet bank trading account report. Transaction statistics in the internet bank will appear during the next 
business day 
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3.5 Quote Monitor 

The main information and trading location of LHV Trader is the trading window, composed of the menu bar, trading bar, 
quick entry section for orders and trading section (with the market data and order information bar). 

There is no limit to the number of Quote Monitors you can create in Trader. You can enter as many lines of market data as 
you want, but at any one time you will only be able to see 100 active market data lines at a time. Use the Quote Monitors to 
sort your assets by instrument type, exchange, or your own trading system categories. You can navigate through the tabbed 
pages without the mouse by using the Ctrl key along with the Page Up and Page Down keys. 

 To create a new page, click the “+” sign and select Quote Monitor 

 To delete a page, click the “x” sign  
 To rename a page, right-click the page title and select Rename Page. 

To add or remove Market Data fields from your Quote Monitor or any tool, hold your mouse over a field until the "Insert" and 
"Remove" commands appear. If you hover over a Market Data field, the list will display the market data categories; if you 
hover over an order field, the list of order fields is displayed. 

 

Market Data fields example: 

Underlying The underlying symbol for the contract. To toggle between underlying and symbol 
mode, on the View menu select the desired mode. 

Exchange The market data exchange. If no other exchange is specified for order routing, this 
exchange is also where the contract will be routed. Select SMART order routing to 
route directly to the best available market. 

Description Identifies the instrument type and other descriptive contract information. 

Position Your current position in the selected contract. 

Avg Price The average cost of the current position. 

P&L Displays gains or losses. To modify the P&L calculation used, right-click the field and 
select or deselect Include today's opening position in P&L calculation. 

NOTE: When the closing price is not available, the average price is used for the P&L 
calculation. This occurrence is noted by an exclamation point (!) in the P&L field. 

Unrealized P&L Calculates unrealized P&L for stocks, stock options and futures options. Unrealized 

P&L is calculated using the formula: 

(current market price - average cost/share) x total number of shares. 

The average cost per share is updated in real time. This field is automatically added 
to the Trading window when the customer takes a position. Once 

removed it is not automatically added again. 

Bid The best bid price for a contract. This is the best price at which you could currently 
SELL. 

Bid Size The approximate depth of the current bid. 

Ask The best ask price for a contract. This is the best price at which you could currently 

BUY. 

Ask Size The approximate depth of the current offer. 

Change How much the current price has risen or declined from the previous day's closing 
price. If the price has declined, the background is red. If the price has risen, the 
background is green. To toggle between dollar change and percent change, click the 
column title. 

Change (%) The percentage that the current price has risen or declined from the previous day's 
closing price. If the price has declined, the background is red. If the price has risen, 
the background is green. To toggle between percent change and dollar change, right 
click the column title and choose Display Value or Display Percentage. 
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Last The last price at which the contract traded. A "C" in front of the last price indicates 
that this is the previous day's closing price. 

For forex the "midpoint" value is displayed instead of the last. 

Last Size The size of the last contract traded. If the last contract traded is larger than the previ-
ous one, the font is green. If it's smaller, the font is red. 

High High price for the day for the selected contract. 

Low Low price for the day for the selected contract. 

Volume Trading volume for the day for the selected contract. 

 
To add or remove Order Management fields from your Quote Monitor, right-click on any field label and select Customize 
Layout. In the list of Order Management columns, move the desired field from the Available Columns list to display, or from 
the Shown Columns list to the Available list to hide. You can modify the layout of fields per page, or globally using a page 
layout that is applied to multiple Quote Monitors. Changes to a page layout are automatically applied to any pages that al-
ready use the layout. 

 

Mandatory Columns are always displayed on an order line in the trading window: 

Action The order action. BUY or SELL. 

Type The order type. 

Quantity The number of units in your order. 

Lmt. Price The limit price for order types to which this price applies, including Limit, Stop Limit,  
and Relative orders. 

Aux. Price This field reflects the Election price for Stop and Stop Limit orders, and the Offset 
Amount for Relative and Trailing Stop orders. You can set these auxiliary amounts in 
the Default Order Settings box. 

Basis Points Used with futures EFPs. The basis point value is equal to the implied interest rate x 100. 

Status The order status. See Guide to System Colors for details. 

 

3.6 The Account window 

The Account window lets you monitor every aspect of your account activity. It presents basic account values as the default 
when your first open the Account window. The account window conveys in real-time the funds you have available for addi-
tional trades and current margin projections. 

 

The Account screen is divided into the following sections: 

 Balances, which shows your account balances for securities, commodities and in total. These balances don't include 
margin requirements. 

 Margin Requirements, which shows your initial and maintenance margin requirements based on your current positions. 
Customers under the Reg T margin model can compare their current margin to their requirements under the Portfolio 
Margin model by clicking the Try PM icon. 

 Available for Trading, which tells you what you have for additional trades and cushion before liquidation, based on your 
balance information and margin requirements. 

 Market Value - Real FX Balance, shows the total value of all positions, sorted by currency. 

 FX Portfolio - Virtual FX Position, which shows activity for currency pair trades only. The value in the Position field only 
reflects trades executed in the FX market. Please note that these do not reflect real-time FX positions, since the non-
base currency conversions may also be included. 
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 Portfolio, which lists all current positions sorted by underlying, and displays the total current market value for each po-
sition. 

 

Balance section 

The Balances section shows your account balances for securities, commodities and in total. These balances don't include 
margin requirements. 

To view all Balances values, expand the section using the green plus (+) sign. To customize this view to show only the    
values you want to see, put a check next to these parameters and click the green minus (-) sign to contract the section. 

The following table defines the fields available in the Balances section. 

Parameter Explanation 

Net Liquidation Value Total cash value + stock value + securities options value + bond value + fund value. 

Equity with Loan Value Total cash value + stock value + bond value + fund value + European & Asian options value. 

Previous Day Equity with Loan Value Marginable Equity with Loan Value as of 16:00 ET the previous day. 

Reg T Equity with Loan Value Total cash value + stock value + bond value + fund value + non-U.S. & Canadian securities 
options value + accrued interest + accrued dividend. 

Special Memorandum Account 

If this values falls below zero at the  
end of the trading day, positions will be liqui-
dated. 

A special account associated with a Reg T Margin account that is maintained for the purpose 
of applying Federal Regulation T initial margin requirements at the end of the trading day.  

Max ((EWL - US initial margin requirements)*, (Prior Day SMA +/- change in day's cash +/- 
US initial margin requirements** for trades made during the day.))  

*calculated end of day under US Stock rules, regardless of country of trading.  

**at the time of the trade 

Securities Gross Position Value (GPV) Equals the sum of the absolute value of all positions except cash, index futures and US treas-
uries. Value of a position is price * size * multiplier 

Cash Settled cash + sales at the time of trade + futures P&L 

Settled Cash Cash recognized at the time of settlement - purchases at the time of trade -  
commissions - taxes - fees.  

Stock Settlement: Trade date + 3 days  

Options Settlement: Trade date + 1 day 

Accrued Interest Interest that has accumulated but has not been paid or charged. 

Dividend Payables Dividends in Lieu that must be paid by the holder of a short position. 

 

 

Margin Requirements section 

Use real-time margin monitoring to see your current margin requirements at a glance, and to understand the margin implica-
tions of any transaction before you transmit an order. 

Margin is calculated at three periods during the day: the market's open, the market's close, and overnight. The Margin Re-
quirements section shows your current margin, projected margin for the next period of margin calculation (Look Ahead) and 
the Overnight calculation (valid for futures only). 

 The Current margin is your real-time requirement right now. If you happen to be viewing this screen at 1:00 AM, your 
current and overnight margin values for your futures positions will be identical. If you're viewing this screen during trad-
ing hours, your current margin requirements for futures will be less than or equal to the overnight requirement. 

 The Look Ahead projects what your margin requirements will be at the next margin calculation, based on what you 
have in your portfolio now. If you're viewing this screen at 2:00 PM, the next calculation will be at the close. If you're 
viewing this screen at 1:00 AM, the next calculation will be at the open. 

 Overnight is the requirement after regular market hours. 
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To help you stay on top of your margin requirements, we provide pop-up messages and color-coded account information to 
notify you that you are approaching a serious margin deficiency. Trader will highlight the row whose value is in the distress 
state. The colors on your account screen tell you the following: 

Yellow - You have only a 5% cushion above the margin requirement 

Note: If your account equity moves rapidly from a greater than 5% cushion to a margin violation, your positions may be liqui-
dated without you receiving a yellow warning. 

Orange - Your margin cushion is depleted and you have a short time to enter into margin-reducing trades before your posi-
tions are liquidated. At this point you will not be able to enter into any trades that might decrease your margin. 

Red - Your positions will shortly start to be liquidated as necessary to bring your account back within the margin limits. 

 

The following table defines the fields available in the Margin Requirements section. 

Parameter Explanation 

Reg T Margin Initial margin requirements calculated under US Regulation T rules. 

Current Initial Margin Initial margin requirement in the base currency of the account. The initial margin re-
quirement is what is required to open a new position. 

Post-Expiry Margin @ Open (predicted) Provides a projected "at expiration" margin value based on the soon-to-expire con-
tracts in your portfolio. Value displays at expiration and are highlighted in red. All 
other times the value is "0". The projected value in this field includes the anticipated 
account value including the expiring contract. To see just the projected margin and 
excess liquidity value for the expiring contract, double click the entry. 

Current Maintenance Margin Maintenance margin requirement in the base currency of the account. This is the 
value required to maintain your current positions. 

Projected Look Ahead Initial Margin Projected initial margin requirement as of next period's margin change in the base 
currency of the account. 

Projected Look Ahead Maintenance Margin Projected maintenance margin requirement as of next period's margin change in the 
base currency of the account. 

Projected Overnight Initial Margin Projected overnight initial margin requirement in the base currency of the account. 

Projected Overnight Maintenance Margin Projected overnight maintenance margin requirement in the base currency of the 
account. 

 
 
Available for Trading 

The Available for Trading values show you the state of your account at a glance. Your Available Funds tells you if you can 
put on a trade. Your Excess Liquidity tells you whether you have sufficient cushion to maintain your current positions, your 
Buying Power tells you how much you have at your disposal including your equity and LHV's margin. 

To view all Available for Trading values, expand the section using the green plus (+) sign. To customize this view to show 
only the values you want to see, put a check next to these parameters and click the green minus (-) sign to contract the sec-
tion. 

The following table defines the fields available in the Available for Trading section. 

Parameter Explanation 

Current Available Funds This value tells what you have available for trading.  

Equity with Loan Value - Initial margin. 

Current Excess Liquidity This value shows your margin cushion, before liquidation.  

Equity with Loan Value - Maintenance margin 

Post-Expiry Excess (predicted) Provides a projected "at expiration" excess liquidity value based on the soon-to-ex-
pire contracts in your portfolio. Value displays at expiration and are highlighted in 
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red. All other times the value is "0". The projected value in this field includes the an-
ticipated account value including the expiring contract. To see just the projected 
margin and excess liquidity value for the expiring contract, double click the entry. 

Special Memorandum Account Line of credit created when the market value of securities in a Reg. T account in-
crease in value. 

Look Ahead Available Funds This value reflects your available funds at the next margin change. The next change 
is displayed in the Look Ahead Next Change field.  

Equity with loan value - look ahead initial margin. 

Look Ahead Excess Liquidity Equity with loan value - look ahead maintenance margin. 

Overnight Available Funds Same as during regular trading hours.  

Overnight Excess Liquidity Same as during regular trading hours. 

Buying Power Cash Account: Minimum (Equity with Loan Value,  Previous Day Equity with Loan 
Value)-Initial Margin 

Standard Margin Account: Minimum (Equity with Loan Value, Previous Day Equity 
with Loan Value) - Initial Margin*4 

Leverage Gross Position Value/Net Liquidation 

Look Ahead Next Change Shows you when the next margin period will begin. 

Day Trades Left Number of day trades still available for 4-day pattern day trader period.  

 
 
Market value – real FX position 

The Market Value section shows you total value for all assets sorted by currency.  

The following table defines the fields in the Market Value section. 

Parameter Explanation 

Currency Open positions are grouped by currency.  

Total Cash Cash recognized at the time of trade + futures P&L. 

This value reflects real-time current FX positions, including: 

 Trades executed directly through the FX market 

 Trades executed as a result of automatic LHV conversions, which   occur 
when you trade a product in a non-base currency, 

 Trades deliberately executed to close non-base currency   positions. 

Settled Cash Total cash that has settled + futures P&L. 

Accrued Interest Reflects the current month's accrued debit and credit interest to date, updated daily. 

Stock Real-time mark-to-market value of stock. 

Options Real-time mark-to-market value of securities options.  

Futures Real-time change in futures value since last settlement. 

FOPs Real-time mark-to-market value of futures options. 

Funds Current funds balance. 

Exchange Rate The currency exchange rate to the base currency. 

Net Liquidation Value Total cash value + stock value + options value + bond value. 

Unrealized P&L The difference between the current market value of your open positions and the av-
erage cost, or Value - Average Cost. 
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Realized P&L Shows your profit on closed positions, which is the difference between your entry 
execution cost and exit execution cost, or (execution price + commissions to open 
the position) - (execution price + commissions to close the position).  

 

 

FX Portfolio – Virtual FX Position 

This section shows activity only for currency pair trades. The "Position" value may reflect the sum of trades executed in the 
FX market along with conversions to convert non-base funds into your base currency. Consequently these “virtual” postions 
do not necessarily reflect your real-time FX positions. For the actual currency balance, check the Total Cash field of the 
Market Value section.  

When the FX Portfolio panel is displayed, currency positions will also be displayed in the trading window. To remove cur-
rency positions from display, condense the FX Portfolio panel by clicking the arrow to the left of the panel title. 

 

Portfolio 

The Portfolio section shows the current value of each position and allows you to mark any position to be liquidated last in 
the event of a margin call.  

The following table defines the fields in the Portfolio section. 

Parameter Explanation 

Show Zero Position Rows - displays a line for all traded contracts even if the position was closed out. 

Contract description Symbol and description. 

Position Quantity of long/short shares or contracts. 

Currency Currency of the contract.  

Market Value (Position) x (market price). 

Market Price Real-time price of the position. 

Average Price Average cost of stock and securities options opening positions, including commis-
sions. 

Note: Right click and select Show all values in base currency to have Trader convert 
all non-base currency position values for display in your base currency. Converted 
values are displayed in italics for easy identification.   

Unrealized P&L (Market value of positions) - (average cost). 

Realized P&L (Market value of positions since close of period*) - (average cost for these posi-
tions). 

*Cut-off times for determining realized P&L for transactions are as follows: 

 20:30 ET for securities 

 Two periods for futures: 17:30 ET and 7:10 ET 

Liquidate Last Last liquidation "Yes" or "No" tag. If set to "Yes" this position will be put at the end of 
the queue to liquidate last in the case of margin requirements. To set, use the right-
click menu on the desired position. 

Note: While LHV provides customers the opportunity to pre-request the order of liq-
uidation in the event of a margin deficiency in their account, such requests are not 
binding on LHV. In the event of a margin deficiency in customer’s account, LHV re-
tains the right, in its sole discretion, to determine the assets to be liquidated, the 
amount of assets liquidated, as well as the order and manner of liquidation. 
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4. Order management 

4.1 Order types 

To create a order 

 Click the Ask price to create a BUY order, or the Bid price to create a SELL order. 

 In the Type field select the order type. 

 If needed set limit price 

 To transmit the order, click the "Transmit" in the Transmit field. 

 

Market order (MKT) A market order is an order to buy or sell an asset at the bid or offer price currently available in the mar-
ketplace. When you submit a market order, you have no guarantee that the order will execute at any specific price. 

Limit order (LMT) A limit order is an order to buy or sell a contract ONLY at the specified price or better. 

Stop order (STP) A Stop order becomes a market order to buy or sell securities or commodities once the specified stop 
price is attained or penetrated. A Stop order is not guaranteed a specific execution price. 

Stop limit order (STP LMT) A Stop Limit order is similar to a stop order in that a stop price will activate the order. However, 
unlike the stop order, which is submitted as a market order when elected, the stop limit order is submitted as a limit order. 
Use the Lmt Price and Aux. Price fields on the trading screen to enter orders requiring multiple prices or values. 

Trailing stop A trailing stop sell order sets the initial stop price at a fixed amount below the market price. As the market 
price rises, the stop price rises by the trailing amount, but if the stock price falls, the stop price remains the same. When the 
stop price is hit, a market order is submitted. Reverse this for a buy trailing stop order. This strategy may allow an investor to 
limit the maximum possible loss without limiting possible gain. 

Trailing stop limit A trailing stop limit order lets you create a trailing stop order that works in conjunction with a dynamically-
updating limit order. When the stop order triggers, a limit order is submitted at the last calculated price (instead of a market 
order which would be submitted with a regular trailing stop order). The Trailing Stop Limit order uses four components: Stop 
price, Trail amount, Limit price, and Limit Offset. 

Limit if touched A limit if touched order is designed to buy (or sell) a contract below (or above) the market, at the limit price 
or better. The Aux. Price value is the trigger to submit the limit order at the specified limit price. 

Market if touched A market if touched order is designed to buy (or sell) a contract when the market goes below (or above) 
the current price. The Aux. Price value is the trigger to submit the market order. 

Trailing market if touched A trailing market if touched is similar to a trailing stop order, except that the sell order sets the 
initial stop price at a fixed amount above the market price instead of below. As the market price falls, the stop trigger price 
falls by the user-defined trailing amount, but if the price rises, the stop price remains the same. When the stop trigger is 
touched, a market order is submitted. Reverse this for a buy trailing market if touched order. 

Trailing limit if touched A trailing limit if touched is similar to a trailing stop limit order, except that the sell order sets the 
initial stop price at a fixed amount above the market price instead of below. As the market price falls, the stop trigger price 
falls by the user-defined trailing amount, but if the price rises, the stop price remains the same. When the stop trigger is 
touched, a limit order is submitted. Reverse this for a buy trailing limit if touched order. 

Limit-on-close An LOC (limit-on-close) order will fill at the closing price if that price is at or better than the submitted limit 
price. Otherwise, the order will be cancelled. 

Market-on-close An MOC (market-on-close) order will execute as a market order as close to the closing price as possible. 

Market-to-limit A market-to-limit order is sent in as a market order to execute at the current best price. If the entire order 
does not immediately execute at the market price, the remainder of the order is re-submitted as a limit order with the limit 
price set to the price at which the market order portion of the order executed. 
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4.1.1 Trigger method 

You can modify the trigger method for Stop, Stop Limit, Trailing Stop and Trailing Stop Limit orders on a per-order basis us-
ing the Order Ticket. You can also set the default trigger method for a strategy using the Trigger Method dropdown in the 
Miscellaneous section of the order. 

To change the default Trigger Method 

 On the Edit menu, select Global Configuration. 

 On the left pane, select Presets. 

 In the Miscellaneous section, Trigger Method dropdown list, select the preferred trigger method that will be used for all 
orders affected by the preset. 

 

Trigger Method Description 

Default Unless the customer modifies any of these features, the default trigger method for all stocks is the 
Last method, described below. 

For US options, the default trigger method is the double bid/ask method, where two consecutive ask 
price (bid price) values must be less than (greater than) or equal to the trigger price, and the second 
bid or ask must have greater size if it is at the same price level as the first bid or ask. 

For Forex contracts (for example EUR/USD currency pair), the default trigger method is bid/ask, 
where the ask price (bid price) value must be less than (greater than) or equal to the trigger price. 

For all other contracts, the default trigger method is the Last method, described below. 

Last For a buy (sell) order to be triggered: 

• One last price value must be greater than (less than) or equal to the trigger price; and 

• The exchange or other market center where the order is to be executed must also publish 
(and the system must also receive) an ask price equal to or higher than, and a bid price equal 
to or lower than, the trigger price; and 

• Last must be within the bid/ask (i.e. >=bid and <= ask) or within leeway percentage outside 
the bid/ask (i.e. >=bid-0.5% of last and <=ask+0.5% of last). This 0.5% amount of leeway is 
subject to change at any time without notice. 

• With the exception of OTCBB- and Pink Sheets-listed stocks, stop and stop-limit order in US 
stocks will also only be triggered if the primary exchange on which the stock trades is open, is 
holding regular trading hours, and has a valid bid/ask quote for the stock. Regular trading 
hours are usually between 9:20 am - 4:00 pm Eastern Time, Monday through Friday for ex-
change-listed stocks. NOTE: This limitation does not apply to stop or stop-limit orders in fu-
tures contracts). 

Double Last For a buy (sell) order to be triggered: 

• Two consecutive last price values must be greater than (less than) or equal to the trigger 
price; or 

• The last price value must be greater than (less than) or equal to the trigger price and the last 
size must be an increase. 

Bid / Ask For a buy (sell) order to be triggered: 

• A single bid (ask) price must be greater than (less than) or equal to the trigger price. 

Double Bid / Ask For a sell order to be triggered: 

• Two consecutive ask prices must be less than or equal to the trigger price; or 

• One ask price value must be less than or equal to the trigger price and the ask size must be 
an increase. 

 

For a buy order to be triggered: 

• Two consecutive bid prices must be greater than or equal to the trigger price; or 

• One bid price value must be greater than or equal to the trigger price and the bid size must be 
an increase. 
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Last or Bid / Ask For a buy (sell) order to be triggered: 

• A single bid (ask) or a single last price must be greater than (less than) or equal to the trigger 
price. 

Mid-point For a buy (sell) order to be triggered: 

• The midpoint of the bid/ask must be greater than (less than) or equal to the triger price. 

 

 

4.2 Time in force for orders 

The time in force for an order defines the length of time over which an order will continue working before it is canceled. We 
support many time in force selections including those described below. 

The selections available for any order are valid based on the combined order type, exchange and product. Not all TIFs are 
available for all orders. 

 

DAY - A Day order is canceled if it does not execute by the close of the trading day. Unless otherwise specified, every order 
is a Day order. 

GTC - A Good-Til-Canceled order will continue to work within the system and in the marketplace until it executes or is can-
celed. GTC orders will be automatically be cancelled under the following conditions:   

 If a corporate action on a security results in an exchange or distribution of shares. 

 If you do not log in to your Trader account for 90 days. 

 At the end of the calendar quarter following the current quarter. For example, an order placed during the third quarter 
of 2016 will be canceled at the end of the fourth quarter of 2016. If the last day is a non-trading day, the cancellation 
will occur at the close of the final trading day of that quarter. For example, if the last day of the quarter is Sunday, the 
orders will be cancelled on the preceding Friday. 

Orders submitted to LHV that remain in force for more than one day will not be reduced for dividends. To allow adjustment 
to your order price on ex-dividend date, consider using a Good-Til-Date/Time (GTD) or Good-after-Time/Date (GAT) order 
type, or a combination of the two. 

For market centers that do not accept "native" GTC orders, the order type is simulated by resubmitting the relevant order 
each business day upon opening of the market center. 

OPG - Use OPG (On opening) to send a market-on-open (MOO) or limit-on-open (LOO) order. 

IOC - Any portion of an Immediate-or-Cancel order that is not filled as soon as it becomes available in the market is can-
celed. 

GTD - A Good-Til-Date order will remain working within the system and in the marketplace until it executes or until the close 
of the market on the date specified. When you select GTD as the time in force, both an Exp. Date and Exp. Time field is dis-
played on the order management line. Enter the date up until which you want the order to continue to work in the format 
YYYYMMDD. To set a time, enter the time in the format HH:MM(:SS). If desired, enter a time zone using an accepted three-
letter acronym. Note that if you do not enter a specific time zone, the time zone to which your computer is set will be used. 

FOK - If the entire Fill-or-Kill order does not execute as soon as it becomes available, the entire order is canceled. 

DTC - A Day 'Til Cancelled order is similar to a day order, but instead of being cancelled and removed from the trading 
screen at the end of the day, the order is deactivated. This means that the order is cancelled AT THE EXCHANGE but re-
mains on your trading screen to be re-transmitted whenever you click the Transmit button. 

Fill/trigger outside RTH - When displayed, checking this option allows orders the flexibility to fill (and/or trigger in the case 
of stop and other trigger orders) both during regular hours and outside of regular trading hours. This option may not be avail-
able for particular products that are not listed on an exchange. 

Good After Time - A "good after time" order is held in the system and sent to the exchange on the date and time you enter. 

Fill or kill - A time in force for options orders, specifying that the order must execute immediately and in its entirety, or be 
canceled. 
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Auction - An auction order is submitted at the Calculated Opening Price (COP). If the order doesn't execute, it is resubmit-
ted as a limit order at the COP or best bid/ask. 

MOO (market-on-open) is a market order executed at the market's open at the market price. 

A LOO (limit-on-open) order is a limit order executed at the market's open if the opening price is equal to or better than the 
limit price. 

 

4.2 Order status colors 

The application uses colored text and backgrounds to convey information about market movement, order destination, and 
order status. Colors are used on all screens that send and receive data, including the Trading screen, the Market Depth win-
dow and the Arbitrage Meter. The meaning of the text colors is consistent throughout the screens. Information on system 
colors is sorted into the following sections: 

Text Colors 

Background colors on a Market Data line 

Background colors on an Order Management line 

Order Status colors 

 

Text Colors 

Colored text on the screen's black background is used to represent up and down movement of price and quantity, and order 
destination information. 

 

YELLOW indicates no change in size or price. 

 

GREEN indicates an upward movement in size or price. 

 

ORANGE (or red) indicates a downward movement in size or price. 

 

For options, the price displayed in PURPLE indicates that the best price is not executing automatically at one or more of 
the exchanges displayed. 

 

MAGENTA - For inter-market spread orders, indicates the implied price of the order. 

 

LIGHT BLUE indicates that this was the last price at which the contract traded. 

 

MEDIUM BLUE indicates that the quote is not currently tradable. 

The page tab text changes color from black to RED to indicate that the page displays an asset for which an order has been 
transmitted. 

 

Background colors on a Market Data Line 
 

 

DARK GRAY across the entire Market Data line indicates that the line is selected. 

The Change field line uses a background color to represent up and down market movement. 
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The Change column identifies the degree and direction of change in the asset's current price from the prior day's clos-
ing price. A RED background in the Change field indicates that the change for the day is negative. 

 

A GREEN background in the Change field indicates that the change for the day is positive. 

 

This PALE RED indicates that trading has been halted on the underlying. 

Change for the day figures are based on 4 P.M. Eastern Time (ET) prior day closing prices. 
 

Background colors on an Order Management Line 

 

A BLUE background in the Action field indicates a BUY action. 

 

A RED background in the Action field indicates a SELL action. 

 

LIGHT BROWN across the entire Order Management line indicates that you have modified a working order but have 
not yet re-transmitted the order. 

 

Order Status Colors 

The color in the Status field of an order management line indicates the status of your order. 

 

LIGHT GRAY indicates that you are in the process of creating an order and you have not yet transmitted it. 

 

LIGHT BLUE indicates that you have transmitted your order, but have not yet received confirmation that it has been 
accepted by the order destination. 

 

PALE PURPLE indicates that an order has been accepted by the system (simulated orders) or an exchange (native 
orders) but that currently the order is not working, due to system, exchange or other issues. When the order becomes 
active, the order status color will change appropriately. 

 

PURPLE indicates that the order has been suspended and is awaiting customer action. Component size is larger 
than the account can support. Please modify the component size or add funds to your account. 

 

DARK BLUE indicates that an order has been accepted by the system (simulated orders) or an exchange (native or-
ders) and that this order has yet to be elected. The order status remains DARK BLUE until the election criteria are 
met. At that time the order is triggered, and the order status color will change appropriately. 
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GREEN indicates that your order has been accepted and is working at the destination. When you display the Shorta-
ble market data column, this color indicates that at least 1000 shares are available to sell short. 

 

DARK GREEN is used in the Shortable column and indicates that this contract can be sold short but that at the mo-
ment there are no shares available for short sale, and that the system is searching for shares. 

 

LIGHT GREEN is used by the Blotter to indicate that a ticket has been accepted by the trader. 

 

PINK indicates that you have sent a request to cancel the order but have not yet received cancel confirmation from 
the order destination. At this point, your order is not confirmed canceled. You may still receive an execution while 
your cancellation request is pending. 

 

ORANGE indicates that a cancellation request has been accepted by the system but that currently the request is not 
being recognized, due to system, exchange or other issues. At this point, your order is not confirmed canceled. You 
may still receive an execution while your cancellation request is pending. 

 

RED indicates that the balance of your order has been confirmed canceled by the system. This could occur unexpect-
edly when the destination has rejected your order. 

In the Shortable column, RED indicates that no shares are available for short sale. Once the order is confirmed can-
celed, the Order Management line will disappear from your trading screen after 30 seconds. 

 

MAROON indicates that an attached simulated order type has been accepted by the system and has yet to be 
elected. The order is held in the system (and the status remains MAROON) until the election criteria are met. At that 
time the order is transmitted to the order destination specified and the order status color will change appropriately. 

 

 

5. Margin requirements 

5.1 Margin introduction 

The definition of margin includes three important concepts: the Margin Loan, the Margin Deposit and the Margin Require-
ment. The Margin Loan is the amount of money that an investor borrows from his broker to buy securities. The Margin De-
posit is the amount of equity contributed by the investor toward the purchase of securities in a margin account. The Margin 
Requirement is the minimum amount that a customer must deposit and it is commonly expressed as a percent of the current 
market value. The Margin Deposit can be greater than or equal to the Margin Requirement. We can express this as an 
equation: 

Margin Loan + Margin Deposit = Market Value of Security 

Margin Deposit >= Margin Requirement 

Borrowing money to purchase securities is known as "buying on margin". The loan in the account is collateralized by in-
vestor's securities and cash. If the value of the stock drops too much, the investor must deposit more cash in his account, or 
sell a portion of the stock. 

The Federal Reserve Board and self-regulatory organizations (SROs), such as the New York Stock Exchange and FINRA, 
have clear rules regarding margin trading. In the United States, the Fed's Regulation T allows investors to borrow up to 50 
percent of the price of the securities to be purchased on margin. The percentage of the purchase price of securities that an 
investor must pay for is called the initial margin. To buy securities on margin, the investor must first deposit enough cash or 
eligible securities with a broker to meet the initial margin requirement for that purchase.  

Once an investor has started buying a stock on margin, the NYSE and FINRA require that a minimum amount of equity be 
maintained in the investor's margin account. These rules require investors to have at least 25 percent of the total market 
value of the securities they own in their margin account. This is called the maintenance margin. For market participants 
identified as pattern day traders, the maintenance margin requirement is $25,000.  

When the balance in the margin account falls below the maintenance requirement, the broker can issue a margin call requir-
ing the investor to deposit more cash, or the broker can liquidate the position.  
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Brokers also set their own minimum margin requirements called "house requirements". Some brokers extend more lenient 
lending conditions than others and lending terms may also vary from one client to the other but brokers must always operate 
within the parameters of margin requirements set by regulators.  

Not all securities can be bought on margin. Buying on margin is a double-edged sword that can translate into bigger gains or 
bigger losses. In volatile markets, investors who borrowed from their brokers may need to provide additional cash if the price 
of a stock drops too much for those who bought on margin or rallies too much for those who shorted a stock. In such cases, 
brokers are also allowed to liquidate a position, even without informing the investor. Real-time position monitoring is a cru-
cial tool when buying on margin or shorting a stock.  

The following table shows stock margin requirements for initial (at the time of trade), maintenance (when holding positions), 
and Overnight Reg T (Regulatory End of Day Requirement) time periods. 

 

5.1.1 US stocks margin requirements 
 

Initial Maintenance Reg T End of Day 

Long position 

25%[1] * Stock Value Same as Initial 50%[2] * Stock Value 

Short Positions 

30%[3] * Stock Value 

30% * Stock Value if Stock Value > $16.67 

 
$5.00 if Stock Value < $16.67 and > $5.00 

 
100% * Stock Value if Stock Value < $5.00 

 
$2.50 if Stock Value <= $2.50 

Same as Reg T End of Day for Long Positions 

Non-Marginable Long or Short Positions 

100% * Stock Value Same as Initial Same as Initial 

 

All Margin accounts must have a minimum of USD 2,000 to trade. 

Margin requirements quoted in US dollars may also be satisfied with a Non-US Dollar equivalent. 

LHV has additional algorithms which increase the nominal margin for positions that represent a >1% holding of an individual 
company’s shares outstanding, with full margin required for concentrations of >= 9% of a company’s shares outstanding 
(For ETFs, full margin is required for concentrations of >= 5%. Investors should be prepared to meet the increased margin, 
where holdings are above 1% threshold 

[1] For Leveraged ETFs, Minimum(25% * Leverage Factor, 100%) 

[2] For Leveraged ETFs, Minimum(50% * Leverage Factor, 100%) 

[3] For Leveraged ETFs, Minimum(30% * Leverage Factor, 100%) 
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5.1.2 US stocks and index options margin requirements 

Combination Type Initial/RegT End of Day Margin Maintenance Margin 

Long Call or Put None Same as Initial 

Short Naked Call Stock Options1 

Call Price + Maximum ((20% 2 * Underlying Price - Out 
of the Money Amount),  

(10% * Underlying Price)) 

 

Index Options1 

Call Price + Maximum ((15% 3 * Underlying Price - Out 
of the Money Amount),  

(10% * Underlying Price)) 

 

World Currency Options1 

Call Price + Maximum ((4% 2 * Underlying Price - Out 
of the Money Amount),  

(0.75% * Underlying Price)) 

 

Cash Basket Option1 

In the Money Amount 

Same as Initial 

Short Naked Put Stock Options 1 
Put Price + Maximum ((20% 2 * Underlying Price -  
Out of the Money Amount),  
(10% * Strike Price)) 
 
Index Options 1 
Put Price + Maximum ((15% 3 * Underlying Price -  
Out of the Money Amount),  
(10% * Strike Price)) 
 
World Currency Options 1 
Put Price + Maximum ((4% 2 * Underlying Price -  
Out of the Money Amount),  
(0.75% * Underlying Price)) 
 
Cash Basket Option 1 
In the Money Amount 

Same as Initial 

 

Covered Calls and Puts   

Short an option with an equity position  
held to cover full exercise upon assignment  
of the option contract. 

Initial Stock Margin Requirement + In the Money 
Amount 4 

Initial Stock Margin Requirement + In 
the Money Amount 4  

Call Spread  

A long and short position of equal number  
of calls on the same underlying (and same 
multiplier) if the long position expires on or af-
ter the short position. 

Maximum (Strike Long Call - Strike Short Call, 0) Same as Initial 

Put spread 

A long and short position of equal number  
of puts on the same underlying (and same mul-
tiplier) if the long position expires on or after 
the short position. 

Maximum (Short Put Strike - Long Put Strike, 0) Same as Initial 
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Collar 

Long put and long underlying with short call. 
Put and call must have same expiration date, 
same underlying (and same multiplier), and  
put exercise price must be lower than call exer-
cise price. 

Initial Stock Margin Requirement + In the Money  
Call Amount 

 

Equity with Loan Value of Long Stock 

Minimum (Current Market Value, Call Aggregate Exer-
cise Price) 

Minimum (((10% * Put Exercise Price) 
+ Out of the-Money Put Amount),  

(25% * Call Exercise Price)) 

Long Call and Put 

Buy a call and a put. 

Margined as two long options.  Same as Initial 

Short Call and Put 

Sell a call and a put. 

If Initial Margin Short Put > Initial Short Call, 

 then Initial Margin Short Put + Price Short Call  

else  

If Initial Margin Short Call >= Initial Short Put,  

then Initial Margin Short Call + Price Short Put  

Same as Initial 

Long Butterfly 

Two short options of the same series (class, 
multiplier, strike price, expiration) offset by  
one long option of the same type (put or call) 
with a higher strike price and one long option 
of the same type with a lower strike price.  
All component options must have the same ex-
piration, same underlying, and intervals be-
tween exercise prices must be equal. 

None Same as Initial 

Short Butterfly Put 

Two long put options of the same series  
offset by one short put option with a higher 
strike price and one short put option with  
a lower strike price. All component options  
must have the same expiration, same underly-
ing, and intervals between exercise prices 
must be equal. 

((Highest Put Options Strike - Middle Put Options 
Strike) + (Middle Put Options Strike - Lowest Put Op-
tion Strike)) 

Same as Initial 

Short Butterfly Call 

Two long call options of the same series  
offset by one short call option with a higher 
strike price and one short call option with  
a lower strike price. All component options 
must have the same expiration, same underly-
ing, and intervals between exercise prices 
must be equal. 

((Highest Call Options Strike - Middle Call Options 
Strike) + (Middle Call Options Strike - Lowest Call Op-
tion Strike)) 

 

 

Must maintain initial margin. 

Long Box Spread 

Long call and short put with the same  
exercise price ("buy side") coupled with  
a long put and short call with the same exer-
cise price ("sell side"). Buy side exercise price 
is lower than the sell side exercise price.  
All component options must have the same ex-
piration, and underlying (multiplier). 

None Same as Initial 
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Short Box Spread 

Long call and short put with the same  
exercise price ("buy side") coupled with  
a long put and short call with the same  
exercise price ("sell side"). Buy side  
exercise price is higher than the sell side exer-
cise price. All component options must have 
the same expiration, and underlying (multi-
plier). 

American Style 

Maximum (1.02 x cost to close, Long Call Strike – 
Short Call Strike) 

 

European Style 

Long Call Strike - Short Call Strike  

Same as Initial 

Conversion 

Long put and long underlying with short call. 
Put and call must have the same expiration 
date, underlying (multiplier), and exercise 
price. 

Initial Stock Margin Requirement 

 

Equity with Loan Value of Long Stock 

Minimum (Current Market Value, Call Aggregate Exer-
cise Price) 

10% * Strike Price 

Reverse Conversion 

Long call and short underlying with short put. 
Put and call must have same expiration date, 
underlying (multiplier), and exercise price. 

In the Money Put Amount + Initial Stock Margin Re-
quirement  

In the Money Put Amount + (10% * 
Strike Price) 

Protective Put 

Long Put and Long Underlying. 

Initial Stock Margin Requirement Minimum (((10% * Put Strike Price) + 
Put Out of the Money Amount),  

Long Stock Maintenance Requirement) 

Protective Call 

Long Call and Short Underlying. 

Initial Standard Stock Margin Requirement Minimum (((10% * Call Strike Price) + 
Call Out of the Money Amount),  

Short Stock Maintenance Requirement) 

Iron Condor 

Sell a put, buy put, sell a call, buy a call. 

Short Put Strike - Long Put Strike  Same as Initial 

 

Specific options with commodity-like behavior, such as VIX Index Options, have special spread rules and, consequently, 
may be required to meet higher margin requirements than a straightforward US equity option. Clients are urged to use the 
paper trading account to simulate an options spread in order to check the current margin on such spread. 

If a combination of options is put on in such a way that a specific strategy is optimal at that point in time, the strategy may 
remain in place until the account is revalued even if it does not remain the optimal strategy. A revaluation will occur when 
there is a position change within that symbol. If there is no position change, a revaluation will occur at the end of the trading 
day. 

1. Minimum charge of USD 2.50 per share of underlying. This minimum does not apply for End of Day Reg T calculation 
purposes. 

2. For Leverage Options, Minimum (20% * Leverage Factor, 100%). 

3. For Leverage Options, Minimum (15% * Leverage Factor, 100%) 

4. For Covered Basket Calls, (short basket call, long component stocks), the margin requirement is for all the component 
stocks. 

 

5.1.3 Futures margin requirements  

Futures margin requirements are based on risk-based algorithms. All margin requirements are expressed in the currency of 
the traded product and can change frequently. 

Risk-based margin algorithms define a standard set of market outcome scenarios with a one-day time horizon. A price scan-
ning range is defined for each product by the respective clearing house. 

In addition to the exchange scanning ranges, we will consider additional scenarios which incorporate extreme moves in the 
underlying. Accordingly, we may require margin over and above the exchange-mandated margin on short options in order to 
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account for the risk inherent in an extreme market move. You can view the current projected margin requirements on a spe-
cific option or futures order that you are considering before you submit the order by creating the order in TWS and using the 
right-click menu to "Check Margin" before you transmit. 

Note that for commodities including futures, single-stock futures and futures options, margin is the amount of cash a client 
must put up as collateral to support a futures contract. For securities, margin is the amount of cash a client borrows. 

 

Intraday Futures Margin and Futures Options Hours 

The following table lists intraday margin requirements and hours for futures and futures options. Each day at 'Intraday End 
Time' the futures contract will revert back to the full overnight margin requirement until the 'Intraday Start Time' the next day. 
Margin requirements will always be applied at 100% for spread transactions. If an account holds futures, futures options for 
US products, or future and index options for European products on the same underlying, intraday margin does not apply. 

 

50% Margin Cut-Off Time 

Exchange Intraday End Time1 

IDEM 17:35 

CDE & NYMEX 15:45 

ECBOT & GLOBEX 15:30 

DTB 21:45 excluding FGBX & FOAT which end 18:45 

SOFFEX 17:15 

HFKE  16:00 excluding A50 which ends 15:45 

ICEEU 16:15 excluding Z which ends 20:45 

IPE 20:45 

KSE 14:50 

MEFRV 17:15 

FTA FTI 18:15 & MFA 18:00 

MONEP 18:00 

NSE 15:15 

OSE.JPN  14:55 NK225 & NK225M 

OSE.JPN 15:00 TOPIX & TOPIXM 

SGX 14:10 NK 

SGX 13:45 NS 

SGX 13:30 TW 

[1] The times listed in 'Intraday End Time' columns are shown in local exchange time. 

 

 

Maintenance Margin Minimums 

Futures: 

50 USD /contract 

Short Options: 

 50 USD/contract for 100 delta units 

 25 USD/contract for 0 delta units 
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Minimums for deltas between 100 and 0 will be interpolated based on the above schedule. Eurex contracts always assume 
a delta of 100. 

 

Initial Margin Minimums 

125% of Maintenance Margin 

 

5.1.4 US single stock futures margin requirements 
 

Combination description Initial Margin Maintenance Margin 

Long or Short SSF 20% * SSF Market Value Same as initial margin. 

SSF Spread 

Long and Short SSF with the same underlying. 

Maximum ((5% * long SSF market value), 
(5% * short SSF value)) 

Same as initial margin. 

Protective SSF  

Long SSF, short stock. 

Short stock margin requirement 5% * Stock Market Value 

Covered SSF  

Short SSF, long stock 

Long stock margin requirement 5% * Stock Market Value 

Protective Call or Put SSF  

Short SSF, long call or long SSF, long put 

20% * SSF market value Minimum ((10% * option strike price) + out 
of the money value, (20% * SSF market 
value)) 

Covered Call or Put SSF  

Long SSF and short call or short SSF and  
short put 

In the money amount + 20% *  
SSF market value. 

Proceeds from the short option are ap-
plied. 

Same as initial margin. 

Collar SSF  

Short call, long SSF, long put Strike (call) >  
Strike (put) 

In the money amount of call + 20% *  
SSF market value. 

Proceeds from the short option are ap-
plied. 

Minimum (In the money amount of call + 
((10%*Put Strike price) + out of the money 
amount of put), (20% * call option strike 
price)) 

Conversion SSF  

Short call, long put, long SSF Strike (call) =  
Strike (put) 

In the money amount of call + 20% *  
SSF market value. 

Proceeds from the short option are ap-
plied. 

In the money amount of call + (10%*call 
and put strike price) 

Reverse Conversion SSF  

Long call, short put, short SSF Strike (call) =  
Strike (put) 

In the money amount of put + 20% *  
SSF market value. 

Proceeds from the short option are ap-
plied. 

In the money amount of put + (10% * call 
and put strike price) 

 

 

5.1.5 Forex margin requirements 

All assets in each currency are combined to determine a single net asset value in that currency. Separate margin require-
ment calculations are used when determining the amount of funds available for withdrawal and the amount of funds availa-
ble for trading. When determining the amount of funds available for withdrawal, the margin for non-base currency assets is 
determined by taking the margin rate from the following table times the net asset value in the currency. There is no margin 
for base currency assets. 
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The following are the margin requirements for each currency: 

Currency Leverage Rate

USD, CAD 40:1

EUR, JPY, AUD 33:1

SEK, NOK, NZD 30:1

CHF 25:1

GBP, HUF, ILS, PLN, SGD, ZAR 20:1

MXN 16:1

CZK, HKD, KRW 10:1

CNH 8.3:1

DKK 6.7:1

RUB 5:1

 

When determining the amount of funds available for trading purposes, margin is required only on negative net liquidation 
values. The margin requirement is calculated as follows: 

 Determine the base currency equivalent of the net liquidation values in the account. 
 Determine the haircut (margin requirement) rate for each currency pair. 
 Determine the largest negative currency balance 
 Sort the haircut rates from smallest to highest. 

 Starting with the positive net liquidation base-currency equivalent with the lowest haircut rate, calculate the margin re-
quirement on that portion which may be used to offset the negative net liquidation valueRepeat step5 until all negative 
net liquidation values have been covered. 

 

5.2 Margin calculations 

LHV applies margin calculations to Reg T Margin accounts as follows: 

1. At the time of a trade 
2. In real-time throughout the trading day 
3. At the end of the trading day 
4. Overnight 

 

At the time of a trade 

Initial Minimum Equity Requirement 
You are required to have a minimum of $2,000 or USD equivalent of securities equity with loan value or commodities net 
liquidation value to open a new position. If you do not meet this initial requirement, you will be unable to open a new position 
in your Reg T Margin account. 

Time of Trade Initial Margin Calculation 
Upon submission of an order, a check is made against real-time available funds. If available funds, after the order request, 
would be greater than or equal to zero, the order is accepted; if available funds would be negative, the order is rejected. 

Available Funds > 0 
(Available Funds = Securities Equity with Loan Value - Initial Margin Requirement) 

Time of Trade Position Leverage Check 
At the time of a trade, we also check the leverage cap for establishing new positions. The leverage limitation is a house mar-
gin requirement that limits the risk associated with the close-out of large positions held on margin. We perform the following 
calculation to ensure that the Gross Position Value is not more than 30 times the Net Liquidation Value minus the futures 
options value. 

Securities Gross Position Value <= 30 * (Net Liquidation Value - Futures Options Value) 
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If the result of this calculation is true, then you have not exceeded the leverage cap for establishing new positions. If the 
trade would put your account over the leverage cap (that is, the calculation is not true), then the order will not be accepted. 

 

Real-Time Margin Calculations 

Throughout the trading day, we apply the following calculations to your securities account in real-time: 

 Real-Time Maintenance Margin Calculation 

 Real-Time Position Leverage Check 

 Real-Time Cash Leverage Check 

 Decreased Marginability Calculations 

 Real-Time SMA Calculation 

 Soft Edge Margining 

Real-Time Maintenance Margin Calculation 
LHV's Real-Time Maintenance Margin calculations is described below. The maintenance margin used in these calculations 
is LHV’s maintenance margin requirement. In the calculations below, "Excess Liquidity" refers to excess maintenance mar-
gin equity.  

Excess Liquidity >= 0 
(Excess Liquidity = Securities Equity with Loan Value - Maintenance Margin Requirement) 

 

Real-Time Gross Position Leverage Check 
There is a real-time check on overall position leverage to ensure that the Gross Position Value is not more than 50 times the 
Net Liquidation Value minus the futures options value. The leverage limitation is a house margin requirement that limits the 
risk associated with the close-out of large positions held on margin. The calculation can be expressed as:  

Securities Gross Position Value <= 50 * (Net Liquidation Value - Futures Options Value) 

If the result of this calculation is not true, positions may be liquidated to reduce the Gross Position Leverage. 

 

Real-Time Cash Leverage Check 
An additional leverage check on cash is made to ensure that the total FX settlement value is no more than 250 times the 
Net Liquidation Value as follows: 

Total Settlement Value of All FX Trades <= 250 * (Net Liquidation Value) 

If the result of this calculation is not true, account liquidation may occur. 

 

Decreased Marginability Calculations 

We reduce the marginability of stocks for accounts holding concentrated positions relative to the shares outstanding (SHO) 
of a company. For Reg T securities accounts, this algorithm increases the margin requirement for stock positions exceeding 
1% of the published SHO from its default to 100% (in other words, decreases the amount of money that can be borrowed 
against a stock position toward zero). At 5% concentration, positions have a 100% margin requirement. 

Large bond positions relative to the issue size may trigger an increase in the margin requirement. The review of bond mar-
ginability is done periodically to consider redemptions and calls, as well as other factors, which may affect the remaining 
liquidity of the particular bond instrument. Less liquid bonds are given less favorable margin treatment. 

 

Soft Edge Margining 

We will automatically liquidate when an account falls below the minimum margin requirement. However, to allow a customer 
the ability to manage risk prior to a liquidation, we calculate Soft Edge Margin (SEM) during the trading day. From the start 
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of the trading day until 15 minutes before the close of the trading day, Soft Edge Margin allows for an account's margin defi-
cit to be within a specified percentage of the account's Net Liquidation Value, currently 10%. When SEM ends, the full 
maintenance requirement must be met. When SEM is not applicable, the account must meet 100% of maintenance margin. 

Soft Edge Margin start time of a contract is the latest of:   

 the market open, the latest open time if listed on multiple exchanges; 

 or the start of liquidation hours, which are based on trading currency, asset category, exchange and product. 

 

Soft Edge Margin end time of a contract is the earliest of: 

 15 minutes before market close, the earliest close time if listed on multiple exchanges; 

 or 15 minutes before the end of liquidation hours; 

 or the start of Reg T enforcement time. 

If an account falls below the minimum maintenance margin, it will not be automatically liquidated until it falls below the Soft 
Edge Margin. This allows a customer's account to be in margin violation for a short period of time. Soft Edge Margin is not 
displayed in Trader Workstation. Once the account falls below SEM however, it is then required to meet full maintenance 
margin. 

Please note that we reserve the right to restrict soft edge access on any given day, and may eliminate SEM com-
pletely in times of heightened volatility. 

 

SMA and End of Day Calculations 

Real-Time SMA 
On a real-time basis, we check the balance of a special account associated with your Reg T Margin account called the Spe-
cial Memorandum Account (SMA). We calculate a running balance of your SMA throughout the trading day, then enforce 
Regulation T initial margin requirements at the end of the trading day. No cash withdrawal will be allowed that causes SMA 
to go negative on a real-time basis. 

End of Day SMA 
As described above, we calculate SMA in real time throughout the trading day, but we enforce Regulation T initial margin 
requirements (typically 50% for stocks or 100% for nonmarginable securities) at the end of the trading day. Whenever you 
have a position change on a trading day, we check the balance of your SMA at the end of the US trading day (15:50-17:20 
ET), to ensure that it is greater than or equal to zero. 

We use the following calculation to check your SMA balance in real time and apply Regulation T initial margin requirements 
to securities that can be purchased on margin. Note that this is the same SMA calculation that is used throughout the trad-
ing day. In the first calculation, "today's trades initial margin requirements" are added for SELL orders and subtracted for 
BUY orders, and are based on US Regulation T Initial Margin requirements. 

SMA = ((Prior Day SMA +/- Change in Day's Cash +/- Today's Trades Initial Margin Requirements) 
or  
(Equity with Loan Value - Reg T Margin)) whichever is greater 

If the SMA balance at the end of the trading day is negative, your account is subject to liquidation. 

 

SMA Rules 

SMA is calculated based on the following rules: 

 Cash deposits are credited to SMA. 

 Cash withdrawals are debited from SMA. 

 Dividends are credited to SMA. 

 Universal transfers are treated the same way cash deposits and withdrawals are treated. 
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 Trades are netted on a per contract per day basis.  

o Realized P&L, i.e. day trading P&L are posted to SMA. 

o Commission and tax are debited from SMA.  

o All trades (one per contract) are posted to the portfolio at the end of the trading day, if RegTMargin of the portfolio 
increases, the increased amount is debited from SMA, if RegTMargin of the portfolio decreases, the decreased 
amount is credited to SMA. The current price of the underlying, if needed, is used in this calculation.  

o Option sales proceeds are credited to SMA.  

o Premiums for options purchased are debited from SMA.  

o The change to SMA resulting from trades is effectively the change in RegTEquity minus the change in RegTMar-
gin.   

 Universal transfers are treated the same way cash deposits and withdrawals are treated. 

 Market appreciation: If RegTExcess of a margin account is greater than SMA at the close (normally 16:00 US/Eastern), 
SMA is set to equal to RegTExcess. Note that SMA balance will never decrease because of market movements. Reg-
TExcess = 0 or (RegTEquity - RegTMargin), whichever is greater.  

 Currency trades do not affect SMA.  

 Fees, such as order cancellation fee, market data fee, etc. do not affect SMA.  

 Exercises and assignments (EA) are reported to the credit manager when we receive reports from clearing houses. 
They will be treated as trades on that day. For example, on expiration, we receive EA notices on the weekend; these 
trades have Friday as trade date in the clearing system, but they will be treated as Monday's trade for SMA purposes 
by the credit manager. Exercise requests do not change SMA. DVP transactions are treated as trades. 

 
Overnight margin calculations 
Stocks and futures have additional margin requirements when held overnight. Futures margin requirements are determined 
by each exchange and can change frequently. LHV applies overnight initial and maintenance requirements to futures as 
required by each exchange.   

How to Determine the Last Stock Price Before We Begin to Liquidate the Position? 
Use the following series of calculations to determine the last stock price of a position before we begin to liquidate that posi-
tion. Note that this calculation applies only to single stock positions. 
 
(Cash Borrowed / # of shares) / (1 – margin rate) = Last Price Before Liquidation 
 
How Much Stock Do We Liquidate? 

We calculate the amount of Excess Liquidity (margin excess) in your Reg T Margin account in real time. If your Excess Li-
quidity balance is less than zero, we will liquidate positions in your account to bring the Excess Liquidity balance up to at 
least zero. 

 

You can use the following calculation to determine how much stock equity we will liquidate in your Reg T Margin account to 
bring your Excess Liquidity balance back to zero. Note that this calculation applies only to stocks. 

Liquidation Amount = Excess Liquidity Deficit * 4 

 

6. Important information 

6.1 Trade FX 

You can trade domestic and foreign securities and currencies from that same account. 

To trade FX from the trading window: 

 Add a market data line using the traded currency symbol. 

 Select the instrument type Forex, and choose the trading currency. 
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Example  

If you want to buy/sell a specific amount of GBP, set up the market data line by entering the symbol GBP (as the transaction 
currency) and selecting Forex as the instrument type. In the Contract Selection box, choose USD as the Currency (settle-
ment currency) from the list in the right pane. You will then receive the quote GBP.USD, with the Bid: 1.6433 Ask: 1.6434. 
This means that GBP 1 = USD 1.64XX  

To buy GBP 10,000, click on the ask and enter 10,000 as the quantity of GBP that you wish to buy. You will pay $1.6434 for 
each GBP. Thus, you will pay $16,434. 

To sell GBP 10,000, click on the bid and enter 10,000 as the quantity of GBP that you wish to sell. You will receive $1.6433 
for each GBP. Thus, you will receive $16,433. 

 

6.2 Corporate actions 

From the investor viewpoint, "a corporate action occurs when changes are made to the capital structure or financial position 
of an issuer of a security that affect any of the securities it has issued," as defined by the Depository Trust & Clearing Corpo-
ration, 2003.   

The owner of the security either voluntarily or involuntarily participates in the reoorganization of a company.  Among the 
most common corporate events are stock splits, reverse splits, mergers, rights offerings, name change, and spin-offs.  Due 
to the effect on share prices and cost basis, each event results in different implications and rules for cost basis adjustments. 

If a corporate action on a security results in an exchange or distribution of shares good til cancel order will be automatically 
cancelled.  

The sale of the subscription rights can be entered from LHV Trader’s system, in case of any issues please contact the cus-
tomer support. Voluntary corporate events should be reported to customer support; the last chance to participate in a volun-
tary corporate event is reporting it by e-mail the 2 days before the end of the event, noting the symbol and amount of and 
the activity with the security (subscription, resale, conversion). 

 

6.3 Closing an account 

Complete the following steps to close your account at LHV: 

Liquidate or Transfer Positions 
Accounts with positions cannot be closed. You must either liquidate, or transfer all positions to another account. Please con-
tact LHV for transfer instructions.  

Convert Foreign Currencies 
Closing withdrawals may be made in several currencies. You can also convert any foreign currency you may hold back to 
your account's base currency.  

Close Account 

Send request to LHV to close Your Trader account: info@lhv.ee Your account will be closed at same month if you send 
closing request before 15-th date, if after, account will be closed in the middle of the next month after monthly fees are 
witheld. After that time, your account will be closed permanently. 

If all funds are withdrawn from the LHV Trader account, the information fee will continue to be debited from the account. The 
account will be closed 30 days after all funds are withdrawn from the account. 

 

6.4 Request a trade cancellation 

You can bust a trade contacting LHV by telephone. In order a trade to be cancelled it has to correspond with certain criteria 
and cancellation can also include additional charges. Trade cancellation requests are handled on a best efforts basis only. 
LHV cannot guarantee your request will be processed within the exchange mandated time limits or will be otherwise ac-
cepted by the exchange. After you inform us of problem or erroneous trades, we will report these trades to the appropriate 
exchange on a best efforts basis. Please note that this is a time-sensitive process. Most exchanges have very short time 
periods (as little as 8 minutes), during which they will accept a request for cancellation.  In addition to uncertainties in re-
sponse speed, trade cancellation requests initiated by telephone are prone to delays identifying the correct account and 
transactions. 
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Guidelines for erroneous Trades vary by market. LHV advises customers to familiarize with criteria used on specific ex-
changes. General criteria: 

Shares under $25: 

Outside regular trading hours - < 20% of the market price 

Regular trading hours - < 10% of the market price 

Shares from $25.01 to-$50: 

Outside regular trading hours - < 10% of the market price 

Regular trading hours - < 5% of the market price 

Shares over $50 

Outside regular trading hours - < 6% of the market price 

Regular trading hours - < 3% of the market price 

The order of the party who conducted a more favorable transaction (purchased for a low price or sold at a high price) is can-
celled without notification of the client. 

Exchanges and market centers often impose a fee for trade cancellation requests in addition to fees charged by LHV. Cus-
tomers are also encouraged to familiarize themselves with all fees associated with cancellation requests prior to initiating a 
request. 

 

6.5 Exposure fee for high risk accounts 

LHV imposes a daily "Exposure Fee" on a small minority of customer accounts that have a very high worst-case loss risk 
exposure. This is to protect LHV and its customers from those accounts that have very risky positions that currently satisfy 
exchange margin requirements, but nonetheless could suffer excessive losses in the event of a significant market move (for 
example, accounts with high exposure to short option positions). 

Exposure Fees only apply to a small minority of customer accounts with unusually risky positions. Most accounts are not 
subject to the fees. The fee is not a higher margin requirement. It is a fee to be deducted from affected accounts to compen-
sate LHV for the risk in servicing such accounts. Please note that the exposure fee is not insurance against losses in your 
account and you will remain liable to LHV for any debt or deficit in your account even if you have paid exposure fees. 

Each day, as part of its risk management policy, LHV simulates profit-loss scenarios for client portfolios based on hypothet-
ical market movements of certain magnitudes ("Exposure Analysis"). The scenarios examined may exceed the parameters 
used by various exchanges for determination of minimum margin requirements.  

As part of this daily process, LHV will calculate an Exposure Fee to be charged to high-risk accounts based on the potential 
exposure the account represents to LHV in the event of a major loss. Under the Exposure Analysis conducted by LHV, if an 
account would lose so much value that its equity would be eliminated and it would then additionally have an unsecured debt 
to LHV (i.e., negative equity), this would represent an Exposure to the firm (since LHV is legally obligated to guarantee its 
customers’ performance to the clearinghouse even if the customer has no remaining equity). 

The Exposure Fee will be calculated for all calendar days and charged to the account at the end of the following trading day. 
Please note the following: 

LHV will calculate the Exposure Fee in its own discretion and using its own proprietary algorithms (which are subject to 
change without notice) to determine the exposure that an account poses to the firm.  

The Exposure Fee may change each day based on market movements, changes in the account’s portfolio, or changes in 
the formulas and algorithms LHV utilizes to determine the riskiness of the account. 

The Exposure Fee will be deducted from affected accounts on a daily basis. You should keep excess capital in your account 
to cover the fee if your account will be affected. If deduction of the fee causes a margin deficiency, the account will be sub-
ject to liquidation of positions as specified in the LHV Customer Agreement.  

The Exposure Fee is judged separately account by account. If you have multiple accounts with offsetting risk exposures, 
you might combine them in order to reduce or avoid the Exposure Fee. 

If you wish to avoid being charged an Exposure Fee, please consider the following: 
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Adding additional capital will improve the risk profile of your account and may reduce or eliminate the Exposure Fee; 

Reducing the exposure in your account by repurchasing short positions in options may also reduce or eliminate the Expo-
sure Fee. LHV has found that short positions in low-priced options generate the largest exposures relative to capital. You 
can use the Risk Navigator to simulate the effects of changes in your portfolio. 

 

7. Day trader rules 

Overview of Pattern Day Trading ("PDT") Rules 

FINRA and the NYSE, as part of a small investor protection agenda, instituted regulations intended to limit the amount of 
trading that can be done in accounts with small amounts of capital, specifically accounts with less than 25,000 USD Net Liq-
uidation Value. 

Day Trade: any trade pair wherein a position in a US security (stock, stock and index options, warrants, T-Bills, Bonds, or 
single-stock futures (SSF)) is increased ("opened") and thereafter decreased ("closed") within the same trading session. 

Pattern Day Trader: someone who effects 4 or more Day Trades within a 5 business day period. A trader who executes 
more than 4 day trades in this time is deemed to be exhibiting a ‘pattern’ of day trading and is thereafter subject to the PDT 
restrictions.  

In order to day trade, the account must have at least 25,000 USD in Net Liquidation Value, where Net Liquidation Value in-
cludes cash, stocks, options, and futures P+L.  

The NYSE regulations state that if an account with less than 25,000 USD is flagged as a day trading account, the account 
must be frozen to prevent additional trades for a period of 90 days. LHV has created algorithms to prevent small accounts 
from being flagged as day trading accounts, to avoid triggering the 90 day freeze. LHV implements this by prohibiting the 4th 
opening transaction within 5 days if the account has less than 25,000 USD in equity.  

 

Adjustments to Previous Day's Equity and First Day Trading 

The previous day's equity is recorded at the close of the previous day (4:15 PM ET). Previous day's equity must be at least 
25,000 USD. However, net deposits and withdrawals that brought the previous day's equity up to or greater than the re-
quired 25,000 USD after 4:15 PM ET on the previous trading day are handled as adjustments to the previous day's equity, 
so that on the next trading day, the customer is able to trade.  

For example, suppose a new customer's deposit of 50,000 USD is received after the close of the trading day. Even though 
his previous day's equity was 0 at the close of the previous day, we handle the previous day's late deposit as an adjustment, 
and this customer's previous day equity is adjusted to 50,000 USD and he is able to trade on the first trading day. Without 
this adjustment, the customer's trades would be rejected on the first trading day based on the previous day's equity rec-
orded at the close. 

 

Special Cases 

Accounts that at one time had more than 25,000 USD, were identified as accounts with day trading activity, and thereafter 
the Net Liquidation Value in the account dropped below 25,000 USD, may find themselves subject to the 90 day trading re-
striction. The restrictions can be lifted by increasing the equity in the account. 

The proceeds of an option exercise or assignment will count towards day trading activity as if the underlying had been 
traded directly. Deliveries from single stock futures or lapse of options are not considered part of a day trading activity. 

 

Examples of Day Trades 

On Monday, 1000 shares of XYZ stock are purchased. Later on that same day, 1000 shares of XYZ stock are sold. This is 
considered to be a day trade. 

On Wednesday, 1000 shares of XYZ stock are purchased. Later on that same day, 500 shares of XYZ stock are sold. This 
is considered to be a day trade. 

On Monday, 500 shares of XYZ stock are purchased. Later on that same day, another 500 shares of XYZ are purchased. In 
after hours trading on Monday, 1000 shares of XYZ are sold. This is considered to be 1-day trade. 
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On Monday, 500 shares of XYZ stock are purchased. On Tuesday, another 500 shares of XYZ stock are purchased. Later 
on Tuesday, 500 shares of XYZ stock are sold. This is considered to be 1-day trade. 

On Thursday, 500 shares of XYZ stock are purchased in pre-market. In after hours trading on Thursday, 200 shares of XYZ 
stock are sold. This is considered to be a day trade. 

On Monday, customer sells short 10 YXX September 2016 90 calls and simultaneously buys 10 YXX December 2016 95 
calls (combination order type). Later on Monday, customer buys back 5 YXX September 2016 90 calls and sells 5 YXX De-
cember 2016 95 calls for a profit. This is considered to be 2 day trades (one day trade for each leg of the spread). 

On Thursday, customer buys 500 shares of YXZ stock. Later on Thursday, customer sells 1500 shares of YXZ stock (rever-
sal creates new short position). On Friday, customer purchases 1000 shares of YXZ stock. This would be considered to be 
1-day trade. 

 

Non-Day Trade Examples 

On Monday, 500 shares of XYZ stock are purchased. On Tuesday, another 500 shares of XYZ stock are purchased. On 
Wednesday, 1000 shares of XYZ stock are sold. None of these are considered to be day trades. 

On Thursday, customer buys 500 shares of YZZ stock. On Friday, customer sells 500 shares of YZZ stock. Later on Friday, 
customer buys 500 shares of YZZ stock. This is not considered to be a day trade. 

On Friday, 1000 shares of XYZ stock are purchased. On the following Monday, 1000 shares of XYZ stock is sold. This is not 
considered to be a day trade. 

 


